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Contacting Etter Industries Incorporated Technical Support

Before calling technical support be sure to have the following information 
available:

- Your version of Microsoft Windows
- Your system configuration (CPU, hard drive, memory etc.)
- Where the problem occurred (in what part of the program were you
- Sometimes we may even need to know what data (numbers etc.) you had 
entered.

Technical support voice: (902) 835 - 6060
Technical support fax: (902) 835 - 5431

Faxing the information can often save you money in long distance charges.    
Remember to include either a voice or return fax number.
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Help on Command Buttons:

Selecting a Button

Help On Desktop Buttons



Desktop Buttons

Loan data Button
Select this button to enter information on Start and first payment date, balloon 
payments, lending institution, borrower, purpose of loan and APR information.

Button Bar
There are a line of buttons on the desktop that do not contain text.    These buttons 
simply have pictures representing their functions.

U.S. Mortgage Button
Select this if your calculation type is a U.S. Mortgage

U.S. Loan Button
Select this if your calculation type is a U.S. Loan

Canadian Mortgage Button
Select this if your calculation type is a Canadian Mortgage

Canadian Loan Button
Select this if your calculation type is a Canadian Loan

Compounded Button
Select this to override the default compounding period

Term Expressed In...    and Period Expressed In...    Buttons
Select these to choose what time period your annuity uses.    I.e. if you entered 12 
in the term box you could select months, years, weeks etc. using the Term button.  
If you selected years your term would be 12 years, if you selected months it would 
be 12 months.    

Variable To Calculate and Calculate Unknown Buttons
Select this button to tell the program which variable (i.e. annual interest rate, 
payment, amortization period, or loan amount) that you want calculated.    The 
variable being calculated is shown in a box in the upper right corner of the 
desktop.    If you have payment as the variable to calculate it calculates 
automatically for you.    If you have one of the others selected you must click the 
Calculate Unknown button to perform the calculation.    Make sure to first enter 
all of the other variables. 

Frequency of Payment Button
Select this button to choose how frequently you make payments.
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Help On Printing Schedules:
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Selecting    A Menu Command:

1. Point to the menu function    in the menu bar that contains the command that
you want and click the left mouse button.    Move the mouse to that 
command and click the left mouse button again to execute the command.

If the command name that is followed by an ellipsis (...),    you are prompted 
to enter further information in a dialog box.

2. If the program displays a dialog box, specify the information required.    If 
you need assistance on the information requested, select the Help button in 
the dialog box.    Select the appropriate button to continue, usually OK or 
Cancel.



Selecting A Button Command:

Move the mouse to the command button that you wish to select.    Click the 
left mouse button.    Further windows may appear requesting information, 
simply answer the prompts to continue.



New File
To    start a new file simply select the menu function File and then New.    
This resets all the values on the desktop so that you can begin to create your
new file.



Open File
To    open an existing file simply select the menu function File and then 
Open.    A standard open dialog window will appear.      Select the document 
you want to open.    In the dialog box, you can select a different drive or 
folder.    You can also type the complete path and filename in the File Name 
box.



Close file
To    close a file you are working on simply select the menu function File and
then Close.    If the file has been changed, you are prompted whether you 
wish the changes to be saved.



Save File
To    save a file simply select the menu function File and then Save.    This 
saves the file under the name under which it was opened,    otherwise it 
opens the standard Save As... dialog window and allows you to select a 
name to save the data under.



Save As
To    save a previously unsaved file or to save a file under a different name 
simply select the menu function File and then Save As.    In the dialog box, 
you can select a file to save by typing a file name, or select a file from the 
folder, or by selecting a different file from a different folder and drive.        
You can also type the complete path and filename in the File Name box.



Delete File
To    delete a file simply select the menu function File and the command 
Delete.    This with delete the file containing the data currently loaded in the
program from the disk.    This menu option will not delete any other file 
except data files.



Cutting and/or Copying Data

1. Locate the data that you wish to cut or copy.    Place the mouse pointer at the
beginning of the section.    Press and hold the left mouse button.    Drag the 
mouse to the end of the desired section.    Release the button.

2. Select Edit from the menu bar and then select Cut or Copy.    The text will 
be either removed and placed in the clipboard (cut) or will be copied and 
placed in the clipboard (copy).



Pasting Data

1. Locate the location where you want the data to be pasted to appear.    Move 
the mouse to this location and click the left mouse button.

2. Select the Edit menu and then select Paste.    The pasted text will appear.



U.S.A. Mortgages

1. Select the U.S.A. Mortgage button on the top of the desk top.    This sets 
the calculations for this operation.

2. Enter the annual interest rate.    The APR can be displayed on the lower 
right hand side of the screen after you enter the interest rate and 
completely calculate a payment.    When you have a payment calculated 
press the APR button to display its value.    The default compound period 
for this interest rate is monthly.    If the interest is compound other than 
monthly, select the compounding button by clicking it and choose the 
appropriate compounding period from the choices shown.

3. Enter the term for which the interest rate has been fixed.    The default 
setting is years.    If this is not the case, select the term in years  button by 
clicking it and choose the appropriate term from the choices shown.

4. Enter the amortization period over which the loan is being calculated.    
The default setting is years.    If this is not the case, select the loan in years
button by clicking it and choose the appropriate term from the choices 
shown.

5. Enter the loan amount.

6. Select the frequency of payment button and enter the how often the 
payments are to be made.    The default is monthly.

7. Select the loan data button.    Through this button you can enter 
information such as lending institution, start and first payment dates.    
Balloon payments etc.    See the section on loan data later in this manual.



U.S.A. Loans

1. Select the U.S.A. Loans button on the top of the desk top.    This sets the 
calculations for this operation.

2. Enter the annual interest rate.    The APR can be displayed on the lower 
right hand side of the screen after you enter the interest rate and 
completely calculate a payment. The default compound period for this 
interest rate is monthly.    If the interest is compound other than monthly, 
select the compounding button by clicking it and choose the appropriate 
compounding period from the choices shown.

3. Enter the term for which the interest rate has been fixed.    The default 
setting is years.    If this is not the case, select the term in years  button by 
clicking it and choose the appropriate term from the choices shown.

4. Enter the amortization period over which the loan is being calculated.    
The default setting is years.    If this is not the case, select the loan in years
button by clicking it and choose the appropriate term from the choices 
shown.

5. Enter the loan amount. 

6. Select the frequency of payment button and enter the how often the 
payments are to be made.    The default is monthly.

7. Select the loan data button.    Through this button you can enter 
information such as lending institution, start and first payment dates.    
Balloon payments etc.    See the section on loan data later in this manual.



Canadian Mortgages

1. Select the Canadian Mortgage button on the top of the desk top.    This 
sets the calculations for this operation.

2. Enter the annual interest rate.    The default compound period for this 
interest rate is semiannual.    If the interest is compound other than annual, 
select the compounding button by clicking it and choose the appropriate 
compounding period from the choices shown.

3. Enter the term for which the interest rate has been fixed.    The default 
setting is years.    If this is not the case, select the term in years  button by 
clicking it and choose the appropriate term from the choices shown.

4. Enter the amortization period over which the loan is being calculated.    
The default setting is years.    If this is not the case, select the loan in years
button by clicking it and choose the appropriate term from the choices 
shown.

5. Enter the loan amount. 

6. Select the frequency of payment button and enter the how often the 
payments are to be made.    The default ids monthly.

7. Select the loan data button.    Through this button you can enter 
information such as lending institution, start and first payment dates.    
Balloon payments etc.    See the section on loan data later in this manual.



Canadian Loans

1. Select the Canadian Loans button on the top of the desk top.    This sets the
calculations for this operation.

2. Enter the annual interest rate.    The default compound period for this 
interest rate is monthly.    If the interest is compound other than annual, 
select the compounding button by clicking it and choose the appropriate 
compounding period from the choices shown.

3. Enter the term for which the interest rate has been fixed.    The default 
setting is years.    If this is not the case, select the term in years  button by 
clicking it and choose the appropriate term from the choices shown.

4. Enter the amortization period over which the loan is being calculated.    
The default setting is years.    If this is not the case, select the loan in years
button by clicking it and choose the appropriate term from the choices 
shown.

5. Enter the loan amount. 

6. Select the frequency of payment button and enter the how often the 
payments are to be made.    The default ids monthly.

7. Select the loan data button.    Through this button you can enter 
information such as lending institution, start and first payment dates.    
Balloon payments etc.    See the section on loan data later in this manual.



Amortization Schedule Setup and Printing

In the File menu there are two menu options that allow you to customize and print
your schedules.    These are Schedule Setup and Print.    Schedule Setup will 
allow you to customize options such as how many of your payments should actually
be printed, subtotaling, and type of schedule.    The Print menu will automatically 
print the schedule to screen and then give you    the options of printing to a file 
(ASCII, and delimited) or to the printer.

1. Select the File menu then select the Schedule Setup Menu.    Click on the 
button that represents the way you wish to have your schedule subtotaled.    
Then select either Print All payments, Print Range or Print only at 
subtotal.    If you select print range then you must enter the start and end 
payment numbers to print in the text boxes below the button.    Selecting 
Print only at subtotal prints only at your specified subtotaling dates.    This
significantly speeds up output.

Next select how the schedule should be calculated.    Your choices are:

Amortization method (which gives you a regular amortization schedule, 
this is the most common type).

Sum of digits method (also known as rule of 78, commonly used in 
installment type loans)    Note that as of January 1, 1983, the Sum of Digits 
method became illegal for consumer loans issued by federally chartered 
Canadian banks.

Multiple Phase - The interest, payment or payment frequency varies during 
the loan.

Select OK to exit.

2. Select the File menu and then select Print.      If the start date and first 
payment date of the loan are more than one payment period apart a window
will appear offering you the chance to adjust the schedule for the extra 
interest paid over these periods.    The program calculates this interest 
amount based on the number of periods between the start and first payment
date.    Check the interest amount given, adjust it to match the actual 
amount charged by the lending institution if they differ.    Then select how 
you would like this interest amount handled and select Continue.  The 
options for handling this interest amount are:    add this amount to the loan 
amount and then calculate a new payment amount based on this new loan 
amount; make a balloon payment on the first payment date to completely 
pay off this interest; or ignore it and calculate the schedule as if it did not 
exist.

3. The schedule will appear on the screen.    You may now scroll through it 
using the scroll bars.    When you are ready click on either Print to Printer, 
Print to ASCII File, or Print To Delimited File. 



4. If you selected Print to a File (either type) a common dialog box will 
appear asking you to enter a name to save the file under.

5. If you have selected Print to Delimited File, another window will appear 
prompting you for the type of file.    Select either Comma,  Semi-Colon, or 
Space.    Due to the way data is handled it is recommended that you use 
Semi-colon.    This option works best with spreadsheets such as Excel 4.0 
for Windows.



Financial Calculator

The Financial Calculator is a basic time value of money Calculator that allows you 
to do basic math but also solve for certain values such as payment, present value, 
and future value, n and %i.

To get to the Financial Calculator select the menu Tools and then the menu option
Financial Calculator.    You can also simply select the icon on the desktop that 
resembles a calculator.

Entering Values For Financial Variables

The Financial Calculator allows the user to solve for certain variables such as 
payment, present value, or future value of an annuity.    However to calculate these
variables the user must enter others.    Following is a description of how to enter 
these values

1. Enter the value for the variable as you would any other number by clicking    
the number buttons.    

2. Notice that at the top of the window there are two rows of buttons.    The top
row has the title Enter Value For....    Here there are buttons for n (number
of periods), %i (interest rate), pmt (payment), pv (present value), and fv 
(future value).    When you click on one of these buttons it assigns whatever 
is in the output display window to that variable.    There are five variables 
that you can assign values.    At any given time three must be filled and then 
you can solve for the fourth.    Ensure that the variable not being used is 
either blank or set to 0.

Solving For The One Unknown

1. Once you have the three values that you already know assigned to three of 
the five buttons you can solve for the fourth unknown value.

2. The second row of buttons from the top of the window has the title Solve 
For...    Click on the button that corresponds to the variable you want 
calculated.    For example, if you entered values for n, %i,    and pv, you 
could then click on the pmt button in the    Solve For... section and the 
program would display the payment.



Loan Payment and Cost of Loan Comparisons

Performing an interest rate or cost of loan comparison is extremely simple 
using this software system.    When doing a comparison, the program uses 
the values for initial interest rate and amortization period that you had 
entered on the desktop.    Then follow these steps to allow the program to 
build the comparison chart.

1. Click in the Calculation Options... button and then select the type of 
comparison (i.e. Interest Rate or cost of loan) that you wish to see.    Click on
the box labeled Amount to increment amortization period and enter the 
incrementing period.    Negative numbers increment down.

2. Click in the box labeled Amount to increment interest rate and enter the
amount to increment the interest rate.    Negative numbers increment down.

3. Click on the calculate button.

4. If you wish you can click on the print button to send the chart to your 
printer.



Date Entry

To enter the date in the program when the date window is displayed:    

1. In the Month field click on month that you desire, it will be highlighted.

2. In the Day and Year fields click on the scroll up/down buttons until you can 
see the selection that you desire.    Click on this selection, it will become 
highlighted.

3. Select OK.



Loan Data

Overview

When you first click on the Loan Data button, located in the lower left 
corner of the desktop, a large window opens displaying many options that 
can be altered.    Only the Start Date, and First Payment Date are necessary 
in an amortization schedule calculation.

Start Date Button
Click this button and the standard date form will appear.    To enter the date 
in the program when the date window is displayed:    

1. In the Month section    click on the up or down scroll bars to show the 
month that you desire in the display area.    Click on the actual word 
that represents the month. The word will be highlighted.

2. Repeat step 1 for the day and year.    When the proper start date is 
shown press OK.

First Payment Button
Click this button and the standard date form will appear.    To enter the date 
in the program when the date window is displayed:    

1. In the Month section    click on the up or down scroll bars to show the 
month that you desire in the display area.    Click on the actual word 
that represents the month. The word will be highlighted.

2. Repeat step 1 for the day and year.

APR Button
After you have entered all of the loan data on the desktop screen click this 
button to display your APR (U.S. mortgages and loans only).      Enter you 
points and fees and then click Calculate to display the result.

Balloon Payment Button
Click on this button and a window will open offering you places to enter 
balloon payments.    Click in the first box where you are indicated to enter 
the amount.    Enter the amount.    Next click in the first box for Payment # 
and enter the number that corresponds to the payment in which this amount
will be added.    When all the balloon payments have been added select the 
Enable Balloon Payment Button.    If you do not select this (when it is 
selected there will be an x inside the box) the balloon payments will not be 
used.    To disable balloon payments select the Enable Balloon Payment 
button again to remove the x.    You can also select continuous balloon 
payments to add a balloon payment to your regular payment every month.    
Simply enter the amount of the continuous amount in the box referring to 
this value and enable it by clicking in the All Payments Have A Balloon 
Payment check button.

Payment At End Of The Month



Select this button to make payments that fall on the last day of each month.  
When this option is selected the button is filled in, when this option is 
turned off this button is not filled.

Purpose of Loan
Click in this large text box and use the DEL key to delete any unwanted text,
then enter the purpose of the loan.    This is for report purposes only.

Lending Institution
Click in this large text box and use the DEL key to delete any unwanted text,
then enter the name and address of the lending institution.    This is for 
report purposes only.

Borrower
Click in this large text box and use the DEL key to delete any unwanted text,
then enter the name and address of the borrower.    This is for report 
purposes only.



Changing WINmortization PRO's Default Settings

The following aspects of WINmortization PRO can be modified once and will 
remain the default upon loading the program:

1. Type of calculation (i.e. Canadian Mortgage)
2. Amount to increment the scrolling buttons
3. Start values for all the desktop data fields
4. The desktop data's color
5. The unknown variable's (variable to solve for) color
6. The default data directory

To modify the type of calculation:    Select the type of the default calculation in the 
Default Calculation Type section.

To modify the increment values or the start data values: Determine which thing 
you want to change (i.e. Interest Rate Increment value) then in either the Default 
Incrementing Value For Scroll Boxes section or the Default Value For 
Desktop Variable Fields section click on the appropriate text entry field.    Delete
any numbers already in this section and then enter the new value. 

To modify the default color scheme: Determine which color you want to modify.    
Select either the Variable Color or Unknown Color button and a color selection 
window will appear.    Select the appropriate color and click OK. 

To modify your default data directory:    Click the Default Data Dir button and a 
Window will appear.    Using the drive and Directory selection windows navigate 
your hard drive until the desired directory is reached.    Double click on this 
directory.    The path that you have selected will be shown at the bottom of the 
window.    When you are finished click OK.    For example, if you wanted to store all 
your data in the directory F:\user\John\Data you would perform the following 
steps.

1. Click on the drive box and scroll down the list until the drive F: appears.    
Select it.

2. In the directory window below double click on the directory User, then double 
click on John, then on Data.    This entire path will be shown.    Select OK to 
continue.

Select the Save button to store this data.    Then select OK.    To cancel your 
changes click Cancel.

These changes will take affect after you have exited WINmortization PRO and then
reloaded it.



The Button Bar

Below is a picture and description for WINmortization PRO's Button Bar.

    OPEN A PREVIOUSLY SAVED DATA FILE

    SAVE THE CURRENT DATA TO A FILE

    DELETE THE CURRENT DATA FROM THE DISK DRIVE

    SET UP THE SCHEDULE OUTPUT PREFERENCES

    PRINT THE SCHEDULE TO SCREEN

    START THE PRESENT VALUE CALCULATOR

    START THE LOAN PAYMENT AND COST OF LOAN COMPARISON 
CALCULATOR



Glossary

Amortization Period
The number of periods over which the loan is calculated.

Amortization Schedule
A schedule displaying how a term loan will be repaid, showing both the 
principal and interest on each payment.    The payments are constant with 
each successive payment paying more principal and less interest.

APR
The annual percentage rate calculates the effective interest rate based upon
any points and/or fees charged for obtaining the loan.

Compounding Interval
The interval or number of times per year interest is compounded.

Interest Rate (effective)
The effective or actual rate of interest after adjusting for compounding 
intervals.

Interest Rate (nominal)
The nominal interest rate quoted by the lending institution.

Term
The period over which the interest rate is fixed.

Principal
The amount of money that is to be repaid by the borrower.



Multiple Phase Loans

In the schedule setup window you are given the calculation option Multiple 
Phase Loans.    This particular type of loan occurs when the interest rate, payment 
amount, or payment frequency changes during the life of a loan.

1. Click the radio button titled Multiple Phase Loan to enable it.

2. Click the Setup Multiple Phase Loan... button to begin setting up the 
multiple phase loan.    When the multiple phase loan window appears simply 
fill in the payment number the change occurs at and then fill in the new 
values for interest rate, payment amount, payment frequency or any 
combination of them.    If the value does not change leave it set to 0.

3. Click OK.




